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Nelprof® is a trademark of Metso Corporation. 

This guide is applicable to Nelprof Version 6.0.3 through 6.2.5. Depending on 
the version of Nelprof you are using you may see minor differences from the 
screen shots herein. Future versions may function differently or have different 
features. From time-to-time Metso adds new products to the list of valves for 
which sizing coefficients are included and fixes bugs. If you make serious use of 
Nelprof to select Metso valves you should make sure you are using the most up-
to-date version. 

Disclaimer 

This guide was prepared by an experienced user of Nelprof. He has no affiliation 
with Metso and no endorsement of this guide by Metso is implied. 

This guide is furnished at no cost on an as-is basis. The author has made a 
reasonable effort to ensure the accuracy and completeness of the information 
herein. However, the information contained in this guide is provided without any 
representation or warranty as to accuracy or completeness or otherwise and 
should be used only as a general guideline and not as an authoritative source of 
technical information. The author will not be held liable for any injury, loss, 
damage or disruption caused, or alleged to be caused, either directly or 
indirectly, by the information contained in this guide. 
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Unlike many valve manufacturer supplied valve sizing programs that only support valves of 

that manufacturer, Nelprof also includes generic data files for most of the common control 

valve styles.  

The “Graphical representation of application” point refers the Nelprof’s ability to graph the 

installed characteristic and installed gain of a control valve. These graphs give a great deal 

of insight as to how well a particular valve will be able to control a particular process.  

The subjects of installed flow and installed gain are discussed in articles that can be found 

on he “LINKS” tab at: 

www.control-valve-application-tools.com 

The subject is also covered in Valin Corporation’s book  Control Valve Application 

Technology. Details about this book can be found on the “BOOKS” tab on the above web 

site. 
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The first time you start Nelprof, it will ask you to enter your e-mail address. Don’t worry, the 

program won’t send you any e-mails. When you print out any valve sizing calculations, there 

is a place at the top of the sizing sheet that says “Created by” followed by whatever appears 

before the “@” symbol. The printout will show any uppercase letters you type as lower case. 

Click OK when you are finished. 
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By default, Nelprof uses the SI system of engineering units. If you want to use US units, you 

can change the default units to US. From the menu select Preferences > Unit defaults. The 

“Default Units for new sizings” dialog appears. Click the “Use US units” button and all the 

units will change to US units. In general you will probably be satisfied with the units the 

program has selected for each parameter. One possible exception is that the program sets 

up “psiA” for pressure units. If you normally like to use psiG, change it now. Open the drop 

down list for Pressure and select psiG.  

 

The list of units is longer than will fit on one screen. On the next slide is the units scrolled 

down so you can see the rest of it.  
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The valve’s “Max capacity” (that is the manufacturer’s rated fully open capacity) and “Req 

capacity” (the valve capacity calculated by the program for each column of process data) 

can be chosen to be either Cv or Kv, or FpCv or FpKv. Cv or Kv are the capacity values 

published by the valve manufacture in their capacity tables. FpCv or FpKv are defined in the 

ISA/IEC valve sizing equation standards as the effective flow capacity of the combination of 

valve with attached pipe reducers. Most people would prefer the units to be Cv  rather than 

FpCv since Cv is what is published by the valve manufacturers. 

You can also have the default noise calculations be by the German VDMA method or by the 

IEC method. Neles’ noise recommendations for avoiding cavitation damage are based on 

the VDMA method. If you plan to use the generic valve files, only the VDMA method works 

tor them. 

You have the option to select the air supply pressure you are most likely to use for actuator 

sizing. You also need to choose which medium type you expect to do valve sizing for most 

frequently. The choices are:  Liquid, Water, Pulp, Gas, Steam and 2-Phase. If you select 

either Liquid or Gas, then you can choose the particular liquid or gas that you will do sizing 

for most frequently from the “Medium” drop down list (providing that your medium is in the 

list). 

At a later date, you can come back to this screen and change your global default units. The 

changes will only apply to new sizings, not to ones you have already done. 

You will see later how you can also assign different sets of default units that will apply to 

only one project. 
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Header and footer fields should be cleared in your Windows internet browser page setup. 

With any web page displayed in Internet Explorer, from the File menu, select “Page setup” 

and make sure all Header and Footer entries are set to “Empty.”  
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To demonstrate how to use Nelprof, we will start out with a sample valve sizing and selection 

exercise that will show how to select the best valve for an application by considering the installed 

characteristic and installed gain. 

Our task is to select a properly sized Neles  R SERIES SEGMENT BALL control valve. The 

process data is given in the table. By entering at least the maximum and minimum flows, along 

with the upstream pressure, P1, and either the differential pressure or P2 at those flow rates, the 

program can calculate how P1 and P2 will behave at all flow rates by fitting parabolic curves to the 

data, using a least squares curve fit. The graph shows how P1, P2 and DP vary with flow. 

The program has the inherent flow characteristics of all Neles and Jamesbury valves, plus generic 

inherent flow characteristics for the most popular valve types. 

Knowing both how the system behaves and what the valve’s inherent flow characteristic is, 

Nelprof can calculate the valve’s installed characteristic and installed gain. 

For this example things like choked flow, noise, and velocity do not affect the selection, allowing 

us to concentrate on installed characteristics and gain. 
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Once Nelprof has been configured with your name,(e-mail address), the set of engineering 

units you want to use and your web browser configured for printing Nelprof results, when 

you start Nelprof, this is what you will see. 

If you want to work on an existing project, select it from this screen. 

If you want to start a new project, as we will be doing for this demonstration,  close this 

“Open” dialog by clicking the Cancel button. 

8 



After closing the “Open” dialog this is what you will see 
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1. From the menu, select File > New Project. An item appears in the Project Tree window with the default 
project name of “Project” (where arrow 3 is pointing) 

2. Click twice on the “Expand/Collapse” button. The project tree expands to show three items below “Project.” 
An “Area,” under the Area a “Tag” and under the Tag a sizing calculation, with the default name of “Control.” 

3. Click on “Project.”  The PROJECT INFO dialog window appears. 

4. Type in the name of the project.(In this example it is “Nelprof Sizing Example.” The program has entered “0” 
in the “Revision” field, the current date in the “Creation date” field and your e-mail address in the “Created by” 
field.  

5. As soon as you save the project the project's default name of “Project” changes to the name you typed into 
the “Project name” field. 

This is a good time to save the project. When you select “Save Project” from the File menu, Nelprof will prompt 
you for a file name. A good choice for the file name would be the same thing you have entered in the “Project 
name” field.  

Each project is saved as an individual file, making it easy to work on the project on a different computer, or 
share it with another person who has a copy of Nelprof. 

When creating a new project, you can choose default units for that project that differ from the set of units that 
you have selected as your global default units. To do this, you must have first saved the project, then you must 
click to open another item in the tree (for example the “Area” item) and then click back on the “Project” item on 
the tree to reopen this PROJECT INFO screen. You can then, in the Project units and defaults dialog near the 
bottom of the screen, click on “Create” and then select the set of units that will be the defaults for that project 
only. If, after you have done some calculations for this project, come back here and create or edit the units for 
the project, the changes will only apply to new sizings, not to ones you have already done. 

 

 

 

10 



To begin a sizing calculation, click on the item in the project tree named “Control.” (Control is 

the default name for a sizing calculation, which you can change later to help keep track of 

several trial calculations for the same valve.) 

When this particular copy of Nelprof was configured for the default set of engineering units, 

Water was selected as the default media type, so when the “Control” was clicked, the Water 

calculation screen came up. Since our sample exercise is for water, this is the sizing screen 

we want. There are buttons for the other possible media. 

Nelprof can do sizing calculations for up to four sets of process conditions. 

Start the calculation process by selecting the valve type you want to do a calculation for. 

Click the “Valve…” button. 
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A list of valve types appears. 

From the drop down list at the upper left of the valve selection window, select “SEGMENT.”  

A list of all the Neles segment ball valves appears. 

Double click on “RE   ROTARY CONTROL VALVE, METAL SEATED, SEGMENT / V-

PORT” (The model “RE” is the standard construction Neles segment ball valve that is 

marketed in North America. 

You will be returned to the main water sizing screen 

 

Note that there is a “GENERIC” category. In the generic category are valve characteristic 

tables, without being identified with a Neles or Jamesbury name or model, of several 

common control valve types. 
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In the line where valve information goes, the Type is SEGMENT, the Pressure rating has remained “All ANSI” 
(which is the default) and the Code is “RE” which is the model number we selected on the previous page, and 
the size is the default “AUTOM” for automatic.” If the Size field is left at “AUTOM” the program will select the 
size of RE segment ball valve that it thinks is the best choice. AUTOM is actually a pretty good choice for 
general sizing. For this example the program would choose a 3 inch valve, which we will see is the best choice. 
Sometimes you might end up choosing a size other than Nelprof’s recommendation. One example of this is that 
if a particular valve would be 80.5% open at maximum flow, it would select one size larger valve because it 
prefers valves that are not over 80% open.  

All of the given process data has been entered into the top portion of the screen. There are fields for both 
Pressure difference and Outlet pressure. You can enter either one of these, and the program fills in the other. 
The program also fills in the vapor pressure of water at the given Inlet temperature, and fills in the Critical 
pressure of water on the left side of the screen. The program uses the density of water at the given Inlet 
temperature in the calculation, but does not show it on the screen. The program also enters shutoff pressure 
“DP-Shutoff” at the bottom of Case 1. The value that the program enters will be the greatest of the Inlet 
pressures that have been entered in the four cases. The user can manually override this value if necessary. The 
shutoff pressure is used in the actuator sizing calculation. 

There are other fields at the left side of the screen which we can ignore. “Special service” will suggest actuator 
safety factors for difficult media which can increase valve torque. “Dpm-factor” is used when installed curves are 
desired when only one set of process data is entered and is an approximation at best. See Section 2.4.4 of the 
Metso Flow Control Manual. Design pressure and temperature fields are for documentation only and have no 
effect on the calculation. 

In this demonstration, we want to show how an installed gain analysis can guide you in selecting the valve that 
will give the best control, so we will do calculations for a 6 inch, a 4 inch and a 3 inch valve and look at the 
installed characteristic and installed gain of each. We will start by forcing the program to do a calculation for a 6 
inch valve. To do this, we left click inside the Size field, then select “6” from the list of all the sizes that the 
Series RE valve is available in. 

The “Actuator sizing” check box has been unchecked. It saves time to postpone selecting an actuator until you 
have selected the exact valve you intend to use. Or you may prefer to leave the actuator sizing  to your sales 
rep. 
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Click the large “Calculate” button and the calculated results appear. In the lower left corner of the 

sizing screen the “Results” field tells us that a 6 inch RE valve has been selected. If we had asked 

the program to select an actuator, the selected actuator would also be listed in the Results area 

below the valve. 

This example was selected so that installed gain would be the only thing that would determine the 

best valve for the application. The other calculated results will be within acceptable limits for each of 

the three valve sizes we will examine. One thing of note in the calculated results is that the six inch 

valve will be operating between about 10% open and 41% open. Most people who subscribe to the 

rule of thumb that a control valve should operate between not much less than 20% open at the 

minimum flow whenever possible and somewhere between 60% and 80% open at the maximum flow 

would say that the six inch valve is oversized for this application. We will look at the installed 

characteristic and installed gain of all three valves after we have done the sizing calculation for all 

three sizes. 

Notice that a small yellow box has appeared on the “Notes and warnings tab. The yellow box means 

that there is something Nelprof doesn’t like about the selected valve and has created a note that 

explains what the program doesn’t like. If there is something Nelprof thinks is really serious, it 

generates a Warning and the box on the Notes and warnings tab will be red. 

You will see what the entire Notes and warnings page looks like later. For now, just the part of the 

Notes and warnings page that has the notes for this calculation has been superimposed on top of the 

valve sizing calculation page (the page that belongs to the “Control” tab). Shortly we will see why 

Nelprof has generated these notes for the 6  inch valve. 

14 



For convenience we will rename this calculation from its default name of “Control” to “6” 

RE” 

Right click on “Control” then select “Rename” In the same manner that Windows 

Explorer lets us rename files, we will be able to change “Control’s” name to “6” RE” 

Press the Enter key to accept the new name. 
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The calculation for the 6 inch RE segment ball valve has been renamed 6” RE 
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It is very easy to create a new calculation for a 4 inch RE segment ball valve. 

Right click on “6”RE” and select “Duplicate” 
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A new sizing calculation appears below “6”RE” named “Copy of 6” RE”  

Right click on this copy and select “Rename” and rename it “4”RE.” 
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Go the “Size” field and select “4” and click the large “Calculate” button. 

The valve travel for a 4 inch valve is between 16% and 56.3%, much closer to the rule of 

thumb of not being much less that 20% open at minimum flow and between 60 and 80% 

open an maximum flow. The notes and warnings tab still has the yellow box, and we have 

superimposed the notes portion of the Notes and Warnings page at the bottom of the sizing 

screen. There is only one note this time, compared to two notes for the 6 inch valve. 
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We have done the same thing to the 4 inch valve as we did to the 6 inch valve to quickly 

create a calculation for a 3 inch valve. 

The travel range for this valve is between about 22% and 73%. And there are no notes or 

warnings, meaning there is nothing Nelprof does not like about this valve. 
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Points 1, 2 and 3 are Neles’ recommendations (and the rules that Nelprof uses when selecting the best valve 

size for an application) for gain magnitude and variation. 

Within the specified control range (by definition we will not  be controlling outside this range so we are not 

concerned with what happens there) that is between q min and q max, the gain should not be less than 0.5, or 

greater than 3.0. 

The definition of control valve gain (upper left equation) says that the installed gain of a control valve equals a 

change in flow  (Dq) divided by the corresponding change in valve position (Dh ). By rearranging the upper 

equation, we can see that a change in valve position (Dh ) multiplied by the gain tells us how much the flow will 

change. If the gain is too low, when the valve moves the flow hardly changes, which means the valve will not 

be effective in controlling flow. If the gain is too high, small errors in valve position  (such as might be caused 

by a sticky valve)  will result in large errors in flow, making it difficult to control accurately. 

Typically, if the gain changes by not much more than a 2 to 1 ratio, it will be possible to come up with  one set 

of PID tuning parameters that will result in good control and stability throughout the required flow range. 

If you can’t find any valve that meets the first three criteria, or if you want to select the best valve of several that 

all meet the first three, then use criteria 4 and 5. 

The gain should be as constant as possible. The more constant the gain, the more aggressive can be the PID 

tuning without the danger of instability. If you had the choice between  Valve 1 and Valve 2, Valve 1 would be 

the best choice because the PID tuning could be more aggressive. 

The gain should also be as close to 1 as possible. Valve 1 and  Valve 3 both allow equally aggressive tuning, 

but Valve 3 is a better choice. 

For a valve position error of 1%, Valve 1 would give a flow error of  about 2% and Valve 3 would give a flow 

error of  about 1%. 
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Now that we have calculations for all three sizes of valves we can select the “Characteristics Curves” tab and compare the 

Installed Flow Characteristic and Installed Gain graphs. The program also generates graphs for the valve’s Inherent Flow 

Characteristic and the Installed Pressure Level (that is, what P1 and P2 are doing as valve travel changes). The Inherent Flow 

Characteristic is interesting because it allows us to see the extent to which the inherent characteristic is modified by the system 

characteristic to produce the installed characteristic. The Installed Pressure Level can help us identify a situation where excessive 

piping pressure losses or an undersized pump make it impossible to get a linear flow characteristic regardless of the valve 

selection. However, it is the Installed Flow Characteristic, and even more so, the Installed Gain that give us a good look at how 

well the valve will be able to control the process. 

For the Inherent Flow Characteristic graph, the Installed Flow Characteristic graph and the Installed Pressure Level graph, the 

graphed parameter is graphed as a function of valve Relative travel, h. Each of these three graphs has two vertical lines, one 

placed at the valve Relative travel at the specified minimum flow (in our example 80 gpm), and one placed at the valve Relative 

travel at the specified maximum flow (550 gpm). On the Installed Gain graph, gain is plotted as a function of q/qm (actual flow 

divided by the maximum specified flow) where 1.0 in our example is 550 gpm. So the vertical line at the left represents 80 gpm 

and the line at the right represents 550 gpm. 

Looking at the Installed Flow Characteristic of the 6 inch valve we see that on the low end, there is not a lot of safety factor. We 

can also see that we are only using about 42% of the valve's capacity. The rest of the valve's capacity is not being used, meaning 

that a 6 inch valve is larger than required for the application. The effect of decreasing pressure drop across the control valve with 

increasing flow has resulted in this equal percentage valve having a fairly linear installed characteristic, especially within the 

specified flow range of 80 to 550 gpm. 

Looking at the Installed Gain graph for the 6 inch valve, we see that the gain varies by slightly more than Neles’ recommended 

maximum of 2:1 within the specified control range, thus the Note about the ratio of maximum and minimum gain. The more the 

gain changes within the control range, the more difficult it is to tune the control loop for both quick response and stable operation. 

Also, the gain has a maximum value of 3.5, higher than Neles’ maximum recommendation of 3.0, thus the note about the 

maximum gain being high. 

The maximum gain of 3.5 occurs at q/qm of 0.7 or 70% of 550 gpm. At this point, a position error of 1% would cause a flow error 

of 3.5%. This would make it difficult for the system to control accurately.  

The conclusion from examining the installed characteristic and gain graphs is that the 6 inch segment ball valve is not an ideal 

choice for this system. 

Here and on the next page, we have superimposed the notes that are actually shown on the “Notes and warnings” tab. 
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Clicking on the 4 inch valve in the Project tree switches the view to the graphs of the 4 inch 

valve. Because the horizontal axis for the installed characteristic graph is valve travel, the 

vertical lines representing 80 and 550 gpm for the 4 inch valve are both at larger openings 

for the smaller valve.  

The installed characteristic is quite linear within the specified flow range, which is good. The 

4 inch valve has more safety factor on the low end, and less wasted capacity on the high 

end.  

Looking at the Installed Gain graph, we see that the maximum gain of the 4 inch valve is 

lower, meaning for the same position error, the flow error will be less. Since the maximum 

gain is less than 3.0, there is no Note about the maximum gain being high. The gain still 

varies by slightly more than Neles’ recommended maximum of 2:1 within the specified 

control range, thus the Note about the ratio of maximum and minimum gain.  

The conclusion is that the 4 inch valve is a better choice than the 6 inch valve. 
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Clicking on the 3 inch valve in the Project tree switches the view to the graphs of the 3 inch 

valve. Because the horizontal axis for the installed characteristic graph is valve travel, the 

vertical lines representing 80 and 550 gpm for the 3 inch valve are both at larger openings 

than they were for the 4 inch valve. 

The minimum and maximum specified flows of 80 and 550 gpm, represented by the vertical  

lines on the installed characteristic graph, are more symmetrically located on the installed 

characteristic, resulting in nearly equal safety factors on both the low end and the high end. 

The installed characteristic is also quite linear within the specified flow range.  

The installed gain graph has the lowest maximum value of all three valves, which will result 

in the lowest flow error for the same position error. The variation in gain within the specified 

flow range is the least of all three valves, making possible the most aggressive PID tuning. 

There were no notes, meaning there is nothing that Nelprof doesn’t like about the 3 inch 

valve. 

 The conclusion is that of the three valves analyzed, the 3 inch valve will provide the best 

control. 

The three pages of graphs can be compared as quickly as you can click between the three 

valves in the Project tree. 
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The Notes and warnings tab shows three things: 

1. A graph of the valve noise throughout the flow range. It is not unusual for the noise to 

peak in the center. If you have done sizing at the minimum and maximum flows, it is 

possible that it may be higher somewhere between the minimum and maximum points 

than at the two points you have calculated results for.  

This graph always displays noise by the VDMA method. 

2. Any remarks you want to make about the calculation. Anything you type in this field will 

appear in the Notes field at the bottom of the printed “Control Valve Sizing sheet.” 

3. Notes and warnings about your calculation that the program has generated. 

4. If you click on one of the Notes or Warnings, the Nelprof User’s Guide will open to the 

section that explains the note you have clicked on. 

(Some earlier versions of Nelprof will simply open the Nelprof users guide to the 

beginning  and you will have  to scroll down to the place where the note is explained.) 
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The User’s Guide has a short discussion of the Theory, the Problem, the Solution, and references to 

where the subject is discussed in the Metso Flow Control Manual which can be accessed from the 

Nelprof Help menu. 
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As mentioned earlier, it will save time if you leave sizing the actuator until you have zeroed 

in on the right valve. Or if you will be purchasing the valve from someone else, you may 

want to let them do the actuator sizing. If you are using the generic valve files for doing the 

sizing calculations, the option of sizing an actuator is not available. 

To size an actuator, put a check mark in the “Actuator sizing” check box. 

Click on the “Actuator” button and a list of the available actuators appears. You might want 

to check with your Metso representative to see which model actuator is most likely to meet 

your needs and would be the most readily available. Double click on the actuator you want 

to select. In the example, the Jamesbury Quadra-Powr (QP) spring diaphragm actuator has 

been selected. 
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The selected QP actuator appears on the “Actuator” line. The default size is “AUTOM” for automatic. You can also select a 

particular size actuator by clicking in the “Size” field and selecting a size from the list that appears. Nelprof has entered 60 

psi for the air supply pressure, because that was the value that was put into the default units dialog when this copy of 

Nelprof was configured. You can type in another value to override the default.  

The shutoff pressure “DP-shutoff” automatically entered by Nelprof at the end of the Flow data section. It chose the highest 

entry on the “Inlet press” line. You can change it to something else if you know the actual shutoff pressure may be higher 

or lower. 

The  default value of the safety factor, entered in the “Safety factor” field is 1. See the next page for additional information 

on actuator Safety factor. 

The field “Special service” on the left side of the screen will suggest actuator safety factors from a drop down list. Note, it 

only makes suggestions, and does not automatically implement them. It is left up to the user to enter any desired safety 

factor in the Safety factor field. 

Click the Calculate button, Nelprof selects a Quadra-Powr spring and diaphragm actuator, size1 with a 60 psi spring and 

displays an analysis of the torque requirements. 

The top row, “To open” and “To Close” gives the torque required by this valve get the ball to move out of the fully closed 

position and the torque required to get the valve fully seated in the fully closed position. In this case 21 foot-pounds to 

open the valve and 17 foot-pounds to close the valve. The “Opening LF” (Load Factor) of 43% on the second line means 

that generating the required  21 ft-lb will take 43% of the torque capability of the actuator when it is starting to open a valve 

from the closed position. The “Control open” and “Control close” are the torques required to modulate the valve a small 

amount in the opening or closing direction from the position the valve is shown to be in in its respective column and the 

“Control open LF” and the “Control close LF” (Load Factor) are the percentage of the actuator’s capability at that point that 

is required to generate that torque. There are columns of Control open and Control close torques and load factors 

corresponding to each of the four sizing cases. 

 When the Safety factor is the default 1, Nelprof selects an actuator based in the rules 1) Neither the “Opening Load 

Factor” or the “Closing Load Factor should be greater than 90% and 2) None of the “Control  open“ or the “Control close” 

load factors should be greater than 60%. 
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The default value of the actuator “Safety factor” entered by Nelprof is 1. For ball valves in dirty, sticky and non-

lubricating service (applications where the process medium can increase the torque required to operate the 

valve) Metso recommends using a Safety factor of 1.5. Also, some end users specify that actuators be sized to 

provide 1.5 times the required operating torque. 

If you enter a safety factor of 1.5, Nelprof should select an actuator that has sufficient torque for a 1.5 safety 

factor, however the program does not change the torque number shown in the actuator results field. 

To be on the safe side, you need to check the Load Factor values shown in the torques field to be sure the 

selected actuator has the required safety factor. 

For a safety factor of 1.5, the “Opening Load Factor” and the Closing “Load Factor” must not be any greater 

than 67%. All of the “Ctrl open Load Factors” and all of the Control close Load Factors” must not be any greater 

than 40%. 

If any of your load factors exceed these criteria, manually select a larger actuator. 

For safety factors greater than 1.1, the maximum “Opening LF” is calculated by:  

     100/Safety Factor 

For the “control”  load factors, the maximum “control…Load Factor” is calculated by: 

     60/Safety Factor 

Load factors for “Control” have to be lower than those for opening and closing the valve because in control the 

actuator must be able to make small smooth adjustments in position. 
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Since in the sizing example, the valve we selected as the best for the application based on the 

installed gain analysis also met the popular rule of thumb that a valve should not be much less than 

20% open at the minimum flow, and somewhere between about 60% and 80% open at the maximum 

flow, the question comes up, why the big deal about looking at the installed gain? One answer is that 

it sounds more professional to choose a valve based on an analysis of how well a valve is going to 

be able to control rather than based on an old rule of thumb. 

The better answer is that the range of opening doesn’t always tell the whole story. A few years ago a 

customer sent us this print out for an Excel valve calculation spreadsheet and asked us if we agreed 

that a 6 inch segment ball valve was a good choice for the application. It certainly lines up with the 

rule of thumb. 

We entered the process conditions into Nelprof and then took a look at the graphs. 
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The installed flow characteristic graph shows that the valve will be operating between 20% and 78% 

open just like the customer’s sizing calculation said. What would have been difficult to know (without 

building the system) was that at 78% open the valve would be flowing more than 90% of its fully open 

capability. There is hardly any safety factor at the high end. Near the 70% open point the installed 

characteristic has flattened out and correspondingly the gain has taken a real nosedive, dropping to 

less than 0.5 at the maximum flow. Throughout the flow range, the gain is changing by more than a 4 

to 1 ratio, which would make it difficult to tune the PID controller for quick and stable control 

throughout the flow range. 

This wasn’t really a valve problem but a system pressure characteristic problem. Looking at the 

Installed Pressure Level graph we see that the pressure difference between P1 and P2 is falling off 

very rapidly as the valve gets close to 78% open. The problem in this case was that the wrong pump 

had been specified. 

The Notes and warnings from the Notes and warnings tab have been superimposed on the screen 

shot. 
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The pump had been specified, but not purchased. The customer found another pump that stared out 

with a higher head, and a curve that had less droop as the flow ran out to the maximum required. 

After analyzing the system for the pressure drop available to the valve at maximum and minimum 

flow incorporating the new pump’s head curve, it turned out that a 4 inch valve  instead of a 6 inch 

valve was required, there was much more safety factor at the high end (at the maximum specified 

flow, the flow is less than 80% of the fully open flow) and the installed gain was much more constant 

throughout the flow range. 

Note that there is no red or yellow box on the “Notes and warnings” tab, meaning there is nothing that 

Nelprof doesn’t like about this application. 
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There are icons on the tool bar at the top of the screen that will add new plant areas under a 

project, new tags under an area and new sizing calculations under a tag. 
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The default entry for the valve “Size” field is “AUTOM” (for automatic). In general this is a good choice. Nelprof will 

select the valve size it thinks is best by looking at a number of things, such as the valve’s percent of opening at 

maximum and minimum flow, the amount of flow safety factor at maximum and minimum flow, noise, cavitation 

potential, installed gain, flow velocity in the valve body, and the size of the selected valve in relation to the size of the 

pipe it is installed in. 

There may be times when you want to compare the automatically selected size to another size. One example is 

when the program selects a larger valve when you would like to use one size smaller valve. It may turn out that the 

smaller valve would be only slightly more than 80% open at maximum flow, and your judgment is that 82% or 83% 

open will be all right for the application. You might also see when you try the smaller valve, there is another reason 

Nelprof does not like it. Perhaps the smaller valve may have a  nose level or flow velocity in the valve body that is 

too high.  

To run a calculation for a valve size other than what Nelprof selects automatically, left click in the valve “Size” field 

and you will see a list of all the sizes that valve style is available in. Nelprof will not accept a size larger than the pipe 

size, and will issue a “note” alerting you that the valve size is small compared to the pipeline size if you select a size 

that is less than one half the pipe size. 

In the screen shot shown here, Nelprof has data for generic equal percentage globe valves from ½ inch to 16 inches. 

(The list is too long for a single screen shot.) 

Some valve styles, such as generic globe valve, Neles Finetrol eccentric rotary plug valves, Neles “Rotary Globe” 

valves and Neles “R” Series segment ball valves (in 1 inch), are available with reduced trim. (Reduced trim means 

valve internals that give the valve a flow capacity (Cv) that is smaller than the maximum capacity that is possible with 

that size valve. 

In Nelprof, reduced trim is indicted by a “\” mark after the nominal valve size followed by a number that tells how 

much reduction from maximum that selection represents. For  example, 1, means a one inch valve with full area 

(maximum available Cv) trim. 1\1 means a one inch valve with one size reduced trim, 1\2 means a one inch valve 

with two sizes reduced trim and so on. The “Max Capacity” field in the “Results” section shows the rated (fully open) 

Cv of the selected size (and reduction when applicable). 
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You can change any individual engineering units that will be applicable to only the one calculation 

you are presently working on (or any new duplicates of that calculation). 

With the “Text select” pointer in the “Unit” field that you want to change left click. A list of all the 

possible units for that unit (in the example the possible units for “Liquid flow”) appears. If we selected 

“lb/h,” lb/h would replace “gpm.” If a value of flow in gpm had already been entered, the dialog “Unit 

changed” would appear. If 10 gpm was already in the Case 1 field, clicking the Yes button would 

change the value to 5002.2 which is the pounds per hour equivalent of 10 gpm of water. Clicking the 

No button would retain the value of 10 which would then represent a flow of 10 lb/h. 
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To print the results of your calculations, click on the check box next to any sizings you want 

to print. You can select one, several or the whole project. In the example above, only “3” RE” 

will be printed. 

From the File menu select “Print.” 

The “Printing” dialog shown above will appear. Under “Select what to print: “Sizings” will be 

checked as a default. This will print all the process inputs and calculated results including 

actuator sizing results. The contents of whatever you have typed in the “Remarks” field of 

the Notes and warnings tab will be printed in the “Notes” field at the bottom of the Sizing 

print out. 

If you want to print any of the graphs, check the “Curves” box, then check the boxes for the 

graphs you want to print. 

To print the notes and warnings that were displayed on the “Notes and warnings tab, check 

the “Notes and Warnings box. 

When you click “OK” you will see a preview of what will be printed. 
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This is a preview of what will be printed. You can scroll down so that you can review 

everything that will print to make sure you are satisfied with it. 
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Here we have scrolled down to see the rest of the Sizing sheet for “3” RE” along with the 

curves that we selected. 

When you click the “Print” button you will see the standard Windows “Print” dialog where you 

select a printer and set its properties. 

 

If you have a need to edit anything that is in the print-out, left click anywhere in the print 

preview and then click on “Select all.” Everything in the preview will be highlighted. Copy all 

of the highlighted content by pressing “Ctrl + C.” 

 

Then open a blank Microsoft Word document and paste the content by pressing “Ctrl + V” 

and a fully editable copy of the print preview will appear. 
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The top row of all the sizing sheets is where you enter information about the piping the valve is 

installed in. 

The valve inlet and outlet pipe diameters are used in the calculation that corrects for the effect of pipe 

reducers. With the exception of the two-phase sizing sheet, for which there is no noise calculation, 

the outlet pipe diameter and either the outlet pipe wall thickness or the outlet pipe schedule are used 

in the noise calculation. 

When a new sizing sheet is opened, the only default entry in the “Pipeline” row is “40” for the outlet 

pipe schedule. 

You should start with entering the inlet pipe diameter. Then when you either click or tab into the outlet 

pipe diameter field, the value you have entered for the inlet diameter is automatically copied into the 

outlet diameter field. Since the vast majority of the time, the upstream and downstream piping will be 

the same size, this saves typing the downstream pipe size. If the downstream pipe is a different size 

you can type in its size to overwrite the automatically entered value. 

Since pipe wall thickness and pipe schedule convey exactly the same information, only one is 

needed. Since you are more likely to know the downstream pipe schedule than its wall thickness, and 

Schedule 40 is the most common schedule, that’s what Nelprof starts with. For any other schedule, 

left click in the Schedule field and a list will appear for you to choose from. 

If you type anything in the “Thickness” field, anything in the “Schedule” field will be deleted. If after 

entering a Thickness, you select a Schedule from the dropdown list, you Thickness entry will be 

automatically deleted. 
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Also common to all of the six of the sizing sheets is the way Inlet pressure, Pressure differential and 

Outlet pressure are handled by Nelprof. 

You can enter any two of the parameters: inlet pressure, outlet pressure and pressure differential in 

any order you want. Nelprof will fill in the third with the appropriate value as soon as you click on 

another field, or press the Enter or Tab key. If you change the pressure differential, Nelprof changes 

the outlet pressure accordingly, and if you change the outlet pressure, Nelprof changes pressure 

differential accordingly. This is all straight forward. The one thing you need to be aware of is that if 

you change the inlet pressure, Nelprof assumes that you want to keep the pressure differential the 

same as it is, so it changes the outlet pressure accordingly. This very possibly would be what you 

intended. On the other hand, if you were to change the inlet pressure you might want to leave the 

outlet pressure and change the pressure differential accordingly. If that is the case, you will need to 

manually put the outlet pressure back to what you intended. As soon as you re-enter the correct 

outlet pressure, Nelprof will put in the appropriate new pressure differential.  

This discussion applies to all six medium sizing calculation sheets. 
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With the exception of the 2-phase sheet, all of the other media sizing sheets have an untitled field 

where you can put anything you want. It will print out in the “Description” field near the top of the 

sizing print-out. The designers of Nelprof had in mind for this field to be used to describe the process, 

something like “Mill water,” “Circulating water”, “Condensate” or whatever. There is room for 33 

characters and spaces on the sizing screen, but you can type in a lot more and it will still print out on 

the printed sheet. 

In the Special service field there is a drop down list where you can select from several types of 

service that are likely to increase the required operating torque of the valve. If the “Recommended 

safety factor” box is checked, the program will make a suggestion (just below the actuator results) of 

how much safety factor to use in selecting an actuator with extra torque. After changing the “Special 

service” field the recommendation only changes after clicking the “Calculate” button. This will be a 

suggestion only. The user must decide what safety factor he wishes to add to the required torque. 

The Dpm-factor makes it possible to generate installed flow characteristic and installed gain graphs 

when only one set of process conditions has been entered. Any graphs will be an approximation at 

best.  See Section 2.4.4 Process model and Dpm selection in the Metso Flow Control Manual. 

The Design Pressure, Design Temperature max and Design Temperature min fields are for 

documentation purposes only. Entries in these fields have no effect on the calculations or operation 

of the program. 
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The water sheet is the simplest to use. Things like the specific gravity and vapor pressure depend on 

the water temperature, and the program figures those out for itself. (The program doesn’t show the 

specific gravity at the operating temperature on the screen, but uses it in the calculation.) The 

program also enters the critical pressure of water. 

All of the inputs are things you will know or easily be able to find out. 

Below the six buttons that select the medium type is a field where you can type anything you want to 

have appear near the top of the printout under “Description.” 

The “Special service” field on the left side of the screen is discussed on the page “Actuator sizing” 

and the “Dpm-factor” is used when installed curves are desired when only one set of process data is 

entered and is an approximation at best.  
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The liquid sizing calculation sheet needs to know either the specific gravity or the density of the liquid and 
also its vapor pressure. 

You do not need to enter a value for viscosity unless you expect it to have an effect on the calculated results. 
The calculations for the installed flow and gain do not include a correction for viscosity, so the graphs will not 
reflect the effect of viscosity. There will be a note with a yellow flag stating “Installed flow characteristics have 
not been analyzed.” 

 

Beginning with Nelprof Rev. 6.2.1 the non-turbulent liquid calculation has been updated to comply with the 
2011 version of the IEC control valve sizing equation standard and the 2012 ISA version of that same 
standard. This should improve the accuracy of non-turbulent flow calculations. 

The IEC and ISA Standards state that the effect of pipe reducers attached to a control valve when flow is 
non-turbulent is unknown. Therefore, the effect of reducers is not included in the IEC/ISA equations of the 
non-turbulent flow coefficient. The Standards make the following suggestion: “The user of such valves is 
advised to utilize the appropriate equations for line-sized valves in the calculation of the FR factor. This 
should result in conservative flow coefficients, since additional turbulence created by reducers and 
expanders will further delay the onset of laminar flow.” The author of this “Using Nelprof” document has no 
argument with the fact that Nelprof includes a reducer calculation and Metso’s inclusion of a reducer 
correction may be justified, but if you want to follow the suggestion of the Standards, when calculating Cv for 
non-turbulent flow you will make the pipeline sizes the same as the valve size for which you are doing a 
calculation. The Standards also state that the methods given for non-turbulent flow are for “non-vaporizing 
fluids” so any indication of choking or flashing would only be valid if the flow was turbulent. Noise calculations 
also only apply if the flow is turbulent. 
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There is drop down list of a number of common liquids. If you are lucky, your liquid will be on the list. 
If it is, select it and the program will insert the density (at 60 degrees F), the critical pressure and the 
vapor pressure at the inlet temperature for you. If  you know the density or specific gravity at your 
actual operating temperature you can overwrite the automatic value with it.  

If you do not select one of the liquids from the drop down list, the program will insert the vapor 
pressure of water without telling you where it got the vapor pressure. The vapor pressure of water is 
a good guess for water based chemicals but for some liquids it may be a very bad guess. 
Something to watch for is, if you manually enter a value for vapor pressure, then later change 
the inlet temperature, the pressure differential or outlet pressure, the program will overwrite 
your vapor pressure value with the vapor pressure of water.  

If you click the “Calculate” button without entering the liquid’s Critical Pressure or Sonic Velocity It will 
insert the critical pressure of water and a typical sonic velocity. The critical pressure of water is a 
very good guess for water based chemicals and not a bad guess if you can't find the actual critical 
pressure of other liquids. The critical pressure of water is greater than for most other liquids, and 
using a critical pressure in the calculations that is higher than the actual critical pressure simply 
makes the calculation of the terminal pressure drop be on the conservative side. The sonic velocity in 
liquids is not easy to find and the value the program uses will be satisfactory. 

Below the drop down list is a field where you can type anything you want to have appear near the top 
of the printout under “Description.” 

The “Special service” field on the left side of the screen is discussed on the page “Actuator sizing” 
and the “Dpm-factor” is used when installed curves are desired when only one set of process data is 
entered and is an approximation at best.  
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Things like the specific gravity and vapor pressure depend on the temperature, and the program 

figures those out for itself. (The program doesn’t show the specific gravity at the operating 

temperature on the screen, but uses it in the calculation.) The program also enters the critical 

pressure of water 

In the drop down list just below the six buttons that select the medium type, select the type of pulp, 

Mechanical, Kraft/chemical, or Recycled. 

The program needs to know the consistency of the pulp. 

Below the drop down list is a field where you can type anything you want to have appear near the top 

of the printout under “Description.” 

The “Special service” field on the left side of the screen is discussed on the page “Actuator sizing” 

and the “Dpm-factor” is used when installed curves are desired when only one set of process data is 

entered and is an approximation at best.  
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The gas sizing calculation wants to know the inlet density of the gas and the ratio of specific 

heats of the gas. 

If you know the actual density of the gas, do not enter the specific gravity or the molecular 

weight. 

If you don’t know the ratio of specific heats for your gas, leave the field blank and when you 

click the calculate button the program will insert a value of 1.4 which is a good guess. 

 

If you don’t know the inlet density, go to the next page. 

 

46 



For most gasses, you probably won’t know the inlet density of the gas, but will know either 

its specific gravity or molecular weight. From either of these, the ISA/IEC gas sizing 

equations include a method that approximates the density from the specific gravity or 

molecular weight and the upstream pressure and temperature. 

As soon as you enter a value for specific gravity or molecular weight, the title of the field that 

was inlet density changes to “Compress” which really means “Compressibility factor.”  

The Compressibility Factor corrects the sizing calculation by the amount the actual density 

of the gas at process conditions will vary from the density of a perfect gas at the same 

conditions. 

 

Continued on the next page. 
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There is a drop down list of a number of common gasses and if your gas is on the list, select 

it and the program will inset the molecular weight and ratio of specific heats and will 

calculate an approximation of the Compressibility factor. 

If you do not select a gas from the drop-down list, but instead enter a known value for either 

specific gravity or molecular weight, the program inserts the compressibility factor for air, 

which will be very close to 1. A compressibility factor of 1 is usually satisfactory (for valve 

sizing purposes) for most gasses at the pressures and temperatures usually encountered in 

industrial processes. You have the option of overwriting a computer inserted compressibility 

factor. However, if you change the inlet temperature or inlet pressure, the program will 

replace your value with its newly calculated value for the compressibility factor of air, based 

on the revised pressure and/or temperature. 

If you know the ratio of specific heats of your non-listed gas, enter it below the Molecular 

weight field. If you don’t enter a ratio of specific heats, the program will insert a value of 1.4, 

which is not a bad guess for valve sizing purposes.  

Below the drop down list is a field where you can type anything you want to have appear 

near the top of the printout under “Description.” 

The “Special service” field on the left side of the screen is discussed on the page “Actuator 

sizing” and the “Dpm-factor” is used when installed curves are desired when only one set of 

process data is entered and is an approximation at best.  
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The steam calculation sheet has an annoying “undocumented feature” that has an 

easy work-around, but you can easily miss it if you are not watching out for it. 

Even though the “Default” US units for steam flow is set to lb/h (pounds per hour) the sheet 

opens with the default flow units set to “scfh” which is not appropriate for steam. 

The work-around is that after opening the calculation sheet, change the units for flow to lb/h 

using the procedure described on the page titled “Changing units for an individual 

calculation.” 

In this case, left click in the field where the “scfh” is shown, then from the list that appears, 

select “lb/h”. 

NOTE that the engineering units of any other parameter on any of the six sizing sheets can 

be changed in the same manner as above. A change made in this way applies only to the 

sizing you have made the change on and any new duplicates of it. 

 

If you are using SI units as your default, the flow units for steam will be, by default, kg/h 

which is appropriate for steam. 
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The other thing you need to know about the steam sizing sheet is that for saturated steam, you can enter either the 

pressure or the temperature, then click the “Saturated steam” button and the program will input the other for you. It 

then enters the resulting inlet density. For superheated steam, if you enter both pressure and temperature, Nelprof 

will calculate the density. If you have a value for density that you think is more accurate, you can overwrite the 

program’s value with yours. Even if you enter your own value for density, you must still enter the inlet temperature 

and inlet pressure. After manually overwriting the value of density you change the pressure or temperature, the 

program will recalculate the density to agree with the new temperature and pressure. 

For steam pressures above 1,500 psi or temperatures above 1,000 degrees F, look up the steam density in a steam 

table rather than using the value that the Nelprof program provides. Neles and Jamesbury do not furnish valves for 

these pressures and temperatures. 

 

Leave the “Spec heats” (the ratio of specific heats) blank. When you click the Calculate button the program will fill it 

in for you. 

 

Below the “Saturated steam” button is a field where you can type anything you want to have appear near the top of 

the printout under “Description.” 

The “Special service” field on the left side of the screen is discussed on the page “Actuator sizing” and the “Dpm-

factor” is used when installed curves are desired when only one set of process data is entered and is an 

approximation at best.  
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The two-phase calculation sheet is used for either mixtures of a liquid and a non-condensable gas, or 

mixtures of a liquid and its own vapor. Here you enter properties for both the liquid and the gas. 

All the comments about entering the various liquid properties that were mentioned in the discussion 

of the water sheet apply to the liquid portion of this sheet and all the comments about entering the 

various gas properties that were mentioned in the discussion of the gas sheet apply to the gas 

portion of this sheet. 

 

There are two drop down list boxes, the upper one for liquids and the lower for gasses. If your liquid 

is on the list, selecting it will enter the density at 60 degrees F and the critical pressure. If it is not on 

the list you will need to manually enter either the specific gravity of density. If your gas is on the list, 

selecting it will enter the molecular weight and the ratio of specific heats. If it is not on the list you will 

need to manually enter either the specific gravity or the molecular weight and the ratio of specific 

heats. If you have selected fluids from the drop down lists, their names will appear on the print-out in 

the Description field at the top of the print-out. 

 

The “Special service” field on the left side of the screen is discussed on the page “Actuator sizing.” 

The Dpm-factor field is not active on the two-phase sheet. 

Nelprof cannot make installed flow characteristic and installed gain graphs for two-phase flow. 
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Now we will talk about the calculated results. 

Shown here are the calculated results that are common to the sizing sheets for all six medium types. 

The “Max capacity” field is the rated or 100 percent open Cv of the selected valve.  (Assuming that when you set up the program 

you selected units of Cv for valve capacity as recommended in the section: “Set default engineering units (continued).) 

The “Req capacity” field contains the calculated required CV for each of the up to four cases. 

The “Travel” and “Opening” fields show how far open the selected valve will be for each of the four cases, in percent of full  travel 

and degrees of rotation respectively. (Degrees of rotation is only applicable to rotary motion valves.) More detail on this on the 

next page. 

If the minimum and maximum valve openings are outside the range that Nelprof finds acceptable, the value for the offending 

result will be in red with an asterisk next to it. (In the print out it will be black with an asterisk.) There will also be a note or warning 

(depending on how seriously the value is outside the acceptable range) on the “Notes and warnings” tab. 

The opening range that Nelprof finds acceptable is: 

Ball & Segment ball valves: Minimum opening greater than 3%, maximum opening between 40% and 90%. 

Globe valves: Minimum opening greater than 10%, maximum opening between 40% and 90%. 

Eccentric rotary plug valves: Minimum opening greater than 5%, maximum opening between 40% and 90%. 

High performance butterfly valves: Minimum opening greater than 10%, maximum opening between 30% and 80%. 

Neles Rotary Globe: Minimum opening greater than 5%, maximum opening between 40% and 90%. 

Note that selections at the extremes of these ranges may be less than ideal. Be sure to check the notes and the graphs. 

The “Noise” field contains the calculated noise (or Sound Pressure Level) for each case. The user can select the calculation 

method to be either IEC or VDMA for Neles and Jamesbury valves. The user can select which method he prefers from the 

“Preferences > Unit Defaults” selection on the menu bar for a global preference, from the Project Info screen using the “Edit” 

button for just one project, or by left clicking in the “Units” field for “Noise” for a single sizing calculation.  For “Generic” valves the 

noise calculation is only available for the VDMA method. There is no noise calculation for two-phase flow. For liquids (Water, 

Liquid & Pulp) the calculated noise also serves as a predictor of the potential for cavitation damage. More on this when we talk 

about results specific to liquids. 

For gas and steam, whenever the noise, calculated by the VDMA method (regardless of which method the screen is displaying), 

exceeds 95 dBA, the value will be displayed in red with an  asterisk next to it. 
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Something that brings up questions from time-to-time is that for most of the Neles and Jamesbury 
rotary valves the percent of travel and the degrees of opening do not appear to match up. That is, the 
percent of travel doesn't agree with the percentage of 90 degrees of a given degree of opening. 

The explanation is that many rotary valves, most notably ball valves, have a dead angle. When a ball 
valve is fully closed (the waterway in the ball is rotated 90 degrees from the axis of the pipeline, and 
then starts rotating in the opening direction, it must rotate until the waterway in the ball is no longer 
covered by the seat. In the case of a three inch Jamesbury soft seated ball valve the dead angle is 
8.5 degrees. 

The percentages of opening (0% to 100%) listed in the Metso Flow Coefficient Manual for a 3 inch 
soft seated ball valve represent the percentages of the valve’s active rotation of 81.5 degrees. The 
upper screen shot was made by entering process conditions that would result in percentages of 
opening of 0%, 50% and 100%. With and input of the barest amount of flow, the valve would have 
rotated 8.5 degrees or essentially zero % of its active 81.5 degrees. With an input of enough flow to 
make the valve travel through 50% of its active 81.5 degrees, it would have rotated a total of 49.3 
degrees from the fully closed position, and with an input of enough flow to make the valve travel 
through 100% of its 81.5 degrees of active rotation, it would have rotated a total of 90 degrees from 
the fully closed position. 

For comparison, the lower screen shot is based on a Metso “Finetrol” eccentric rotary plug valve. 
This valve has no dead angle, so its active rotataion is the full 90 degrees that it can rotate. So at 
zero percent open, it has rotated zero degrees, at 50% open it has rotated 45 degrees, and at 100% 
open it has rotated 90 degrees. 

Linear motion valves, such as globe valves will have no results in the “Opening” field. 
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Metso makes recommendations for evaluation of  the potential for cavitation damage based 

on calculated noise levels using the VDMA calculation method.  The recommended noise 

limits for avoiding cavitation damage are given in Table 1, Section 3.3.2 of the Metso Flow 

Control Manual, copied below. 

Whenever a calculated noise (calculated based on the VDMA method) exceeds the 

recommended limits, the value will be in red with an asterisk next to it. Regardless of 

whether you are viewing the VDMA noise or the IEC noise, it is the VDMA calculation that 

determines whether the value appears in red with the asterisk. 

 

 

 

 

 

 

 

 

Note that the  Metso Flow Control Manual can be accessed from the Nelprof Help menu. 
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In addition to the results that are common to all media and the information discussed on the previous 

page regarding noise and cavitation, the water, liquid and pulp sizing sheets have the three rows of 

results in common that are shown below the grayed out area. 

Many valve manufacturers make recommendations for the maximum liquid flow velocity in the valve 

inlet. Metso makes recommendations in the Metso Flow Control Manual in Section 3.7. if any of the 

values exceed the recommendation, the value appears in red with an asterisk. 

The “Terminal dp” (terminal pressure drop) is the pressure drop beyond which liquid flow will become 

choked. Operating at or beyond the choked flow point will result either in flashing or potentially 

damaging levels of cavitation. Cavitation and potential valve damage usually begin before the choked 

flow point (terminal dp) is reached. If flashing conditions are predicted by Nelprof, no value will be 

shown in the “Terminal dp” field, but instead the word “flashing” appears. 

What Neles calls “Terminal dp” or DPT has been called different things in different literature. Some 

examples are: DP(allowable) , DPmax , DPcrit , and choked DP. For the first time, in the 2012 edition of the 

ISA/IEC valve sizing standard, they have given it the name “DP(choked).” 

The “Fl coeff.” (the Liquid Pressure Recovery Factor)) commonly written as “FL“ is a valve parameter, 

determined by valve manufacturer’s testing, that appears in the formula that calculates the valve of 

Terminal dp. The formula is: DPT = FL
2(P1 - FFPV) 

Section 3.1 of the Metso Flow Control Manual discusses choked flow. 

You don’t really need to know what value of FL Nelprof is using, but some users want to have FL 

entered on their control valve data sheets. 
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Shown here, below the grayed out portion of the results are those results that are common to gas 

and steam. 

The “Flow velocity” field represents the gas or steam velocity in the valve’s outlet port expressed as a 

Mach number. 

Metso recommends that the flow velocity be limited to 0.5 Mach for continuous throttling duty and 0.7 

Mach for infrequent occasions such as gas-to-flare and blow-off valves. High valve outlet velocities 

can generate noise levels that are higher than what is calculated by the various noise prediction 

methods. Whenever the value of Mach number exceeds 0.5, the value will appear in red with a 

asterisk. 

The “Xt coeff”, more commonly written xT, defines the pressure drop ratio at which gas flow becomes 

choked. Choked gas flow is not associated with valve damage as is the case with liquid choked flow, 

but it is necessary for the valve sizing program to know if flow is choked to be able to accurately 

calculate the required valve Cv.  

You don’t really need to know what value of xT Nelprof is using, but some users want to have xT 

entered on their control valve data sheets. 
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Shown here, below the grayed out portion of the results are those results that apply to the two-phase 

sizing results. 

The “Effective density” of the two phase flow stream is needed by Nelprof to calculate the required 

Cv. It is determined from the upstream densities of the liquid and gas components, along with the 

mass fractions of the two, taking into account the expansion and resulting density change of the gas 

component as it accelerates toward the vena contracta. You don’t really need to know what the 

effective density is. 

The “terminal dp” is the pressure drop at which flow becomes choked. To the author’s knowledge, 

there have been no studies of whether two-phase choked flow has any damaging effects.  

There is no known method for calculating noise in two-phase flow. 
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Nelprof was designed to help its sales reps and customers size and select Metso (Neles and Jamesbury) 

valves, but its designers also recognized that there are times when users want to document sizing calculations 

without the documentation listing a specific Metso valve by name or model number. To accommodate this 

need, files have been provided for the sizing of “Typical” valves of the most commonly used types. 

In general, if a 4 inch “Generic” segment ball valve is suitable for a particular application, then it is almost 

certain that a 4 inch segment ball valve from any of the leading manufacturers will also be suitable. 

After clicking on the “Valve…” button, select GENERIC to see the list of choices pictured above. 

There is one minor “annoyance” that will be fixed in a future update. 

Sometimes one of the calculated values will be shown in red with an asterisk, along with a warning note. If the 

value is within acceptable limits, the warning can be ignored. 

 

The actuator sizing option is not available for generic valves. 
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To export a Nelprof 6 project file for importing on another computer that has Nelprof 6 installed, open 

the folder on your computer that contains the Nelprof project files. It is simple to open this folder. 

Simply select from the Nelprof menu: File > Open Project File   and the screen shown above opens. 

Right click on the project file you want and select “Copy.” Then paste it to some other location the 

same way you cut and past files with Windows Explorer. 

If you are going to send the file using Microsoft Outlook, simply drag the file onto the e-mail message. 

If you are importing a project file, simply drag it or copy it to this same folder. 
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To delete sizings, tags or plant areas you have to first select the object (tag, sizing or plant area) you 

want to delete. This is done by clicking once the object you want to delete (object will be highlighted). 

In 1 above the sizing 6” RE is selected for the delete function . 

Right click the object and select Delete. 

Note that all checked and filled in boxes must first be cleared before deleting an item. 

 

(Check marks and filled in check boxes are used for printing, and for mass calculation functions). 

 

You cannot delete projects. You can close a project from the file menu, File > Close File 

 

If you want to delete a file, go to File > Open Project File 

Then delete the file like you would delete any file in Windows Explorer. 
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Example: Change the Liquid flow in Case 2 from 550 to 600 in the calculations for 6” RE, 4” RE and 3” RE.  

 

To make a change to a number of sizing calculations and then recalculate them, do the following: 

Step 1. Fill in the check boxes to the left of the sizings that you want this change to be applied to as in 1 above. 
Sizing calculations 6” RE, 4” RE and 3” RE have check boxes filled in. 

Step 2. Modify the flow in Case 2  in any of the sizings that need to be modified to read 600 gpm. 

Step 3. From the menu, select     Edit > Mass Editing     The program asks if you are sure. Click OK.  Finally the 
program confirms that the new value (600) was put in three places. Click OK 

The check boxes next to all three sizings will have check marks in them to indicate that the operation is complete. 

You can only edit one field at a time and the insertion point must remain in the edited field when you 
click Edit > Mass Editing. You can edit several fields in this way before you perform the mass calculation 
described on the next page. 

Be aware that fields that depend on the one you have changed are NOT changed. For example, when you 
change Inlet pressure, Outlet pressure is automatically changed on the sheet where you are doing the editing, 
but does not carry over to the rest of the sheets you have checked off. Another example is on the Water and Pulp 
sizing sheets, vapor pressure depends on temperature. The changed temperature will carry over but the 
corresponding vapor pressure does not. The new vapor pressure (or other dependent fields) can be transferred 
to the other sheets by clicking in the dependent field of the sheet you are doing the editing in, then again select 
Edit > Mass Editing. 

If you were only changing a field in three calculations it would probably be faster to just click on the sizings on at 
a time and make the change to each one, but if you had to make the change to 50 calculations, the procedure 
described above would be much easier. 

Continued on next page. 
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Step 4. Then we calculate selected sizings by selecting from the menu    Calculation > Mass 

Calculation    The program asks if you want it to stop if one of the calculations fails. (If you have 500 

sizings, you might want to calculate them all first and then see which ones did not complete, so then 

select No.) In the Project tree you will see the three sizings that you have put check marks for briefly 

highlighted sequentially while each is calculated. Assuming that all three calculations were completed 

successfully you will get the message that all were successful. 

If any of the calculations fails, there will be a message box telling you how many calculations failed 

and how many completed successfully. The check boxes for the calculations that were successful 

will have a grey background and the ones that failed will have a white background. 
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There are several situations in which Nelprof cannot create a model of the process, and therefore it 

cannot generate the installed graphs. In these cases you will get a note on the “Notes and warnings” 

tab: “Installed flow characteristics have not been analyzed.” 

In a physical system with significant piping and/or a centrifugal pump, P1 must decrease with flow 

and P2 must increase with flow. If there is very little piping, then it is possible for P1 and/or P2 to 

remain constant. In a system where pumps and piping are the only effects, P1 CANNOT increase 

with flow and P2 CANNOT decrease with flow. If the data you input shows this happening, NELPROF 

cannot construct a mathematical model of the piping system, and therefore will not be able to draw 

the installed graphs.  

It is possible to have valid data that does not meet the above criteria, but it will be the result of 

designing the system for unrelated circumstances. 

For example a low flow and low value of P1 may be specified for the way the plant will operate for the 

first several years. A higher flow and higher P1 may be specified for the situation several years in the 

future when higher flow rates are anticipated, and it is planned to install a higher capacity and 

HIGHER PRESSURE pump. For purposes of obtaining the graphs, these two unrelated situations 

must be treated as two separate systems, evaluated separately. 
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Nelprof cannot construct a mathematical model of the piping system if two sets of pressure 

conditions are given for a single flow rate. 

Here, it is possible to have such a system (for example a flow control system where load 

disturbances change the upstream or downstream pressure). Nelprof, however, cannot construct 

graphs. 

Nelprof only knows the relationship between flow and piping pressure loss for turbulent flow where 

pressure loss is proportional to flow squared. 

The relationship between flow and pressure loss for laminar or transitional flow is NOT included in 

Nelprof. 

Nelprof will draw the installed graphs if a value of viscosity has been entered, but the graphs are 

based on turbulent flow, which may or may not actually be the case. 

To test for the validity of the graphs, do the calculations with the value of viscosity entered and note 

what percentage open the valve is. Then repeat the calculation, but with the viscosity deleted. If the 

percentage of valve opening changes by less than, say, 5 or so percentage points, you can assume 

that viscosity has negligible effect on the sizing calculation. 

The piping pressure drop calculations for two phase flow are very complex, and Nelprof does not 

attempt to draw graphs for two phase flow. 
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